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A Message from George Lucas

Creative Director of Lucas Learning Ltd.

Many years ago as a filmmaker | developed an interest in interactive technologies. As | began
to work with them, | realized that they had great potential for opening up new kinds of
learning experiences for young people. They offered an alternative to some of the traditional
approaches to education that did not work for me as a youth. As a result, for over 15 years
I've been committed to finding ways to capture kids’ natural interest in learning and engage
them more actively and productively in the learning process. Lucas Learning reflects my own
passion for learning as it creates products like this one. The Gungan Frontier explores rich

content in an immersive and entertaining environment as it engages the player in constructing
and managing an ecosystem. | hope you enjoy the experience and that it will contribute to
your own lifetime of learning.

George Lucas
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Lucas Learning Ltd. Company Philosophy Statement

Lucas Learning Ltd. is committed to creating uncommon learning opportunities through software
that inspires and entertains. Our games are imaginative, challenging, and engaging, yet grounded
in solid content and an understanding of how we actually learn. Our philosophy is based on a
fundamental respect for people’s natural desire to direct their own learning through exploration
and discovery. Our goal is to provide you with an entertaining, enduring, and substantial learning
experience set in the familiar worlds of the Star Wars galaxy.
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If you have an Internet connection, please take a minute to register your product. After
registering you'll be able to download extra Star Wars creatures to add to your Gungan |
Frontier for FREE! This will also give you access to online technical support and allow us

to keep you informed of program updates, contests, new products, online events, and

whatever else we dream up!

The first time you insert The Gungan Frontier CD, you will be asked if you would like to register.

In Windows 95 or 98, you may also register by clicking on START on the Windows Task Bar,
then Programs, then Lucas Learning, Star Wars The Gungan Frontier, Register Online.

On the Macintosh, you may also register by clicking on either the Netscape Navigator or
Internet Explorer documents in The Gungan Frontier folder on your hard drive. This should
bring you to the Lucas Learning registration web site.

Note: You may need to be connected to the Internet before you can register.
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Windows 95/98 Users

Installation
If AutoPlay is enabled on your system, simply insert The Gungan Frontier disc into your CD-ROM drive.
In a few seconds, the launcher should appear. Follow the prompts to complete the installation.

If AutoPlay is not enabled on your system, follow these steps:

1. Insert The Gungan Frontier disc into your CD-ROM drive.

2. Double-click on the My Computer icon on your desktop.
3. Double-click on your CD-ROM drive (typically drive D:).
4. Double-click on the Launch.exe icon.

5. Register electronically via the Internet.
6. Click on Install Star Wars - The Gungan Frontier.

Follow the on-screen prompts to finish installing The Gungan Frontier.

Please see the ReadMe.txt file for last-minute changes and information. To access the ReadMe.txt
file before or after installing, click on View ReadMe on the game launcher.

Start-Up

If AutoPlay is enabled on your system, simply insert The Gungan Frontier CD into your drive.

The launcher will appear automatically. Click on the Play Star Wars The Gungan Frontier button
to start the game.

If AutoPlay is not enabled on your system, follow these steps:

1. Click on the Windows Start button (on your Task Bar)
2. Click on Programs

3. Click on Lucas Learning

4. Click on Star Wars The Gungan Frontier

5. Click on Play Star Wars The Gungan Frontier




Macintosh Users

Installation
1. Insert The Gungan Frontier disc into your CD-ROM drive.
2. Double-click on The Gungan Frontier CD icon on your desktop.
3. Double-click on Install The Gungan Frontier.

Follow the on-screen prompts to finish installing The Gungan Frontier.

Please see the ReadMe file for last-minute changes and information.

Start-up

To start The Gungan Frontier, double-click on the Lucas Learning folder on your hard drive (or the folder

that you have installed to.) Next, click on The Gungan Frontier folder. Double-click on The Gungan Frontier
icon to launch the game.
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The Gungan Frontier

The underwater city of Otoh Gunga has become dangerously overcrowded. Colonization of the
water moon of Naboo is about to begin.

In preparation, the Gungans have collected many exotic creatures from the small planet of Naboo
and from throughout the galaxy that should thrive on the empty moon. Establishing an ecosystem
in which the new plants, animals and Gungans can all live in balance is not an easy task.

The Gungan Council has called upon Obi-Wan Kenobi and Queen Amidala, heroes of the Battle
of Naboo, to meet this challenge...

In The Gungan Frontier, you will fly to the empty water moon of Naboo to set up a new underwater
home for the Gungans. The Gungans need food and raw materials to build a new underwater city.
Your mission is to populate the moon with plants and animals and advise the Gungans on what to
harvest. If you never harvest, there will be no city. If you harvest too much, everyone will suffer.

While it might seem like The Gungan Frontier is just a game, it actually simulates real-world ecological
principles with fantastic animals and plants. A player explores the interconnectedness of people
(Gungans, actually), animals, plants, and the environment, as well as population and life cycle
dynamics, food webs, and many other important ideas that apply to our lives here on Earth.




As with any simulation, only certain variables are taken into account, and others are omitted.

The Gungan Frontier tracks every individual animal and plant on the surface of the moon and knows
who is hungry when, when the last time each critter reproduced, what types of terrain lifeforms
like to forage in, how long a lifeform can live, how many babies are in a litter of tookes, and

so on. There are also some real-world variables that have not been included in the simulation:
weather, temperature, time of day, seasons, nests and refuges, drinking, sexual reproduction
(except for the narglatch), and migration.

We hope you enjoy playing The Gungan Frontier, While you are playing, keep in mind that the key
to success is balance.

Getting Started

If you would like detailed instructions on how to play The Gungan Frontier, please read the MAIN MENU
and PLAY sections in this manual. If you would like to get started playing as quickly as possible, read the
QUICK START directions.

Characters

In The Gungan Frontier, Boss Nass asks you for help creating and maintaining a colony of Gungans on the
water moon of Naboo. He needs one volunteer to accompany Jar Jar and R2-D2. Each time you begin
a new game, you may choose to be either Queen Amidala or Obi-Wan Kenobi.

Queen Amidala

Queen Amidala is the recently elected ruler of the
Naboo. Young, talented and extremely well-trained,
she has great compassion for her people and for all
living things. The Queen is an excellent choice for
your mission.

Obi-Wan Kenobi

Obi-Wan Kenobi is a young and noble Jedi Knight.
Since Jedi are peacemakers who help communities and champion justice,
Obi-Wan is also very well suited for the challenges of The Gungan Frontier.




Boss Nass

Boss Nass is the leader of the Gungans and head of the High Council. He has
called upon the heroes of the Battle of Naboo to help set up a new colony on
the moon. He is tough, but he cares about his people. See the In-Game Help
section of this manual for more information.

R2-D2

R2-D2, a faithful astromech droid who was helpful

in the Battle of Naboo, will accompany you on your
adventure. R2-D2 can communicate with your probe
droid and will give you important information about
the new ecosystem. See the In-Game Help section of
this manual for more information.

And to keep you company...

Jar Jar Binks

Jar Jar is a clumsy but friendly Gungan who frequently gets into trouble. Most of the
time he putters around off-screen in other parts of your ship. Occasionally he sticks his
head out and lets you know what he's thinking. If he's getting on your nerves you can
tell him to go take a nap by selecting Jar Jar Asleep in the Settings menu.

Quick Start

Can't wait to start playing? Here's a brief description of how to begin.

Note: If you attempt to start playing The Gungan Frontier for the first time and have never completed the
Training Mission, a screen will appear suggesting you try the Training Mission first.

1. Click on New Game on the Main Menu screen.
2. Click on Beginner on the Game Selection screen.

Note: In the Beginner game, your ship is automatically loaded and a landing site on the moon
is chosen for you.



3. Watch the introduction to the game and listen to Boss Nass describe your mission.
4. Choose which character you would like to be, Queen Amidala or Obi-Wan Kenobi.

5. Watch as your ship is loaded; a site is selected; and your ER-1C probe droid is released. The probe droid
divides in two. One part will monitor the underwater Gungan city and the other part flies into the sky and
monitors the animals and plants on the surface of the moon. The images these probes send back to you
will be what you see in your holoviewer.

6. Now you are looking at your ship’s console and a holographic projection of the surface of the moon.
The console is loaded with tools and buttons that will help you create and monitor a new ecosystem and
Gungan city. The moon is empty and you have a spaceship full of plants and animals. It's time to go to work!

7. At the center of your ship console is the Species Indicator. The Species Indicator shows the currently
selected species of plant or animal. Move the mouse over the ground or water and click to release the
current species onto the moon. The more times you click, the more creatures will be released. If the plant
or animal can't live in the terrain you clicked on, R2-D2 will let you know. Move your cursor to the edge
of the screen to move around the moon. The holoviewer will stop moving if you reach the edge of the
probe droid’s sensor range. You are unable to release anything outside of sensor range.

Note: In the Beginner game, food for each critter you release is automatically released onto the moon
along with the critter. If you do not wish to have food for your critters automatically released, press
the | . on your keyboard (i.e. turn caps lock on).

8. Click on the Species Indicator to open the Food Web (or press the [*) key on
your keyboard) and select a new critter or plant. Click on the critter in the center
of the Food Web to close the web and begin releasing that critter onto the moon.

9. Click on the Tool Selector and choose the Bio-Scan tool. Scan your critter or click on another
one in order to see how that critter is faring in its new environment.

10. Click on the Harvest button to open the Harvest screen. Are you ready to let the e
Gungans start collecting this species for use in their city? If so, click on the maintain

button. The Gungans will then harvest any amount of this species that grows beyond the current
population level, helping that species to maintain its current population level on the moon.

11. Open the Food Web again. Choose another plant or animal. Click on the critter in the center
of the Food Web to close the Food Web and begin releasing more creatures.

Have fun! Remember, the key to success lies in building and maintaining a balanced ecosystem on
the water moon of Naboo.
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[HE GUNGAN FRONTIER

After the Lucas Learning logo plays, you will see the Main Menu screen.
It's easy to spot - there should be all sorts of creatures walking across
your screen! The Main Menu is your gateway to The Gungan Frontier. From
the Main Menu you can begin a new game, load a saved game, create
your own critters, and more!

o

Training Mission

If you are new to The Gungan Frontier or are simply unsure of how to play the game, the Training Mission is
a good place to start. While completing the Training Mission, you will learn the key elements necessary to
successfully build and maintain a new ecosystem on the moon of Naboo.

Your ultimate goal is to maintain a healthy, vibrant underwater bubble city for the Gungans. To support
this new population of Gungans, you must build and maintain a healthy ecosystem on the surface of the
moon. You will release plants and animals and advise the Gungans on what they can harvest. On the way
to completing the training mission, you'll receive helpful pointers, such as how to navigate the Food Web
and how to turn on Bubble Help.

Note: Many game features in the Training Mission are inactive
until you need them.

New Game

When you select New Game, the Game Selection screen will appear.
You must choose between Beginner, Advanced, and Missions.

Beginner

Beginner is a good choice if you have already played the Training Mission or if you
are interested in building an ecosystem on the moon as quickly as possible. Your
ship will be automatically loaded with a well-balanced set of plants and animals. A landing site
will be chosen for you. You will then be able to release critters and plants into their new habi-
tat. The number of critters you have on your ship is unlimited, and when you release an animal
onto the moon, food will be automatically released for it (and food for its food!).

Note: If = is on, auto-food release is turned off in the Beginner game.

10



ADVANCED Advanced

When you understand how to play The Gungan Frontier and are ready for a greater
challenge, the Advanced game is a good choice.

In the Advanced game, you will be responsible for loading your ship with up to 12 species each
of animals and plants. If you are not happy with the critters you have loaded, you can cancel

the lift-off by clicking Abort Launch, then choose new animals and plants. Once you leave Naboo
and fly to the moon, however, you will not be able to return, so you must choose carefully.

In the Advanced Game, you will need to select a site on the moon that has the right type of land
for your plants and animals. Unlike in the Beginner Game, the number of critters you can release
on the moon is limited to the number of each species you have aboard your ship. Also, you will
need to release food for any critter you release. Harvest levels will need to be carefully set and
monitored in order to balance the needs of the underwater Gungan city with those of your
newly-created ecosystem on the surface.

MISSIONS M iSSi ons

If you are looking for more goal-oriented game play, missions are for you.
Each mission, whether it is easy, medium or hard, presents you with an ecological
challenge that needs to be solved.

There are 13 missions, not including the Training Mission.

They are:
Easy Medium Hard
Garden Moon Endangered Kaadu Blow in the Wind
Happy Herbivores Food Fight Clodhopper Alert
New Gungan Home Hydenock Campaign Greedy City
Save the Poms Peko Peko Peril The Domino Effect

Veermok Chow

Click on a mission and a brief explanation of the mission goals will appear.

11
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Load Game

This button allows you to load a game that you have previously saved. If you have no saved games,
a dialog box will appear with that message.

Create-a-Critter

Here you have the opportunity to create and name your own plants and animals. You can even decide
their behaviors! All of the animals and plants you create in Create-a-Critter will appear in the game, just
like any other. Look for them in the Food Web, Index, and Kresch. For further explanation of the Food
Web, Index, and Kresch see the PLAY section of this manual.

When you create a lifeform in The Gungan Frontier, you get to decide the following for both plants
and animals:

* Name of the lifeform

e Kingdom (plant or animal)

e Size (small, medium, or large)

* Habitat (water, land, or amphibious)

e Color (both primary and secondary)

» Offspring (number and frequency of reproduction)

e Life-span

For animals only:

* Food (herbivore or carnivore, and size of food)
e Speed

* Sound

» Whether the animal travels in a herd or not

When you click on Save Critter, the lifeform you have created will be added to the list of critters you can
load onto your ship. Make sure you remember what you called your creation, so you can find it in the Index.

Options

The Options screen allows you to customize your game play.

Performance Options

Clicking on the circle to the left of each option
(such as Bones), toggles it on and off.

Turning off any of the performance options will change how the game looks and may also improve
how The Gungan Frontier performs on your computer. For optimal performance, turn all options off.



Terrain Quality

There are four settings, Low through Very High. They refer to the detail with which the ground and
ground cover plants are drawn on the screen. Lowering the Terrain Quality setting will change how
the terrain looks and may also improve how The Gungan Frontier performs on your computer. For optimal
performance, set the Terrain Quality to Low.

Sound and Visual Effects

Move the sliders by clicking and dragging them with your mouse. Move the sliders to the right to raise
the volume or brightness. Move them to the left to lower the volume or brightness.

Credits

Click this button to see a list of all the people who worked hard to create The Gungan Frontier. The credits
are also included in this manual.

Quit

Click Quit to close the game and return to the desktop.

M Play P

Choose A Character

In The Gungan Frontier, Boss Nass asks you for help creating and maintaining a colony of Gungans on
the water moon of Naboo. He needs one volunteer to accompany Jar Jar and R2-D2. You may choose

to be either Queen Amidala or Obi-Wan Kenobi. For more information on these characters, please see
CHARACTERS in the OVERVIEW section of this manual.

Load Your Ship

Your ship needs to be loaded with plants and animals that can survive together. This is done for you
in the Beginner game. In the Advanced game, you must do this yourself. Your ship can hold up to 12

species of animals and 12 species of plants, but choose carefully. Once you leave Naboo, you can not
return for more creatures.

13
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Food Web

The Food Web screen is where you will choose animals
and plants to load on your ship.

Use the Load button to choose a species that you
want on your ship.

@ The Unload button removes that species from
your ship.

Some species take up more than one slot on your ship. Kaadus, for example, need space for their eggs.
If your ship is empty and you load kaadu adults, kaadu eggs automatically get loaded as well. You will
then be able to load ten more animal species. If you unload kaadu adults, the kaadu eggs will auto-
matically be unloaded.

Note: When you load a creature or plant, the amount loaded has been predetermined for you. You
need only concentrate on selecting the right mix of species for your new ecosystem.

The Food Web has two tabs on the right hand side, Food Web and Index. When Food Web is highlighted,
you will be able to see what the displayed critters can eat and what eats them. The plant or animal
pictured in the center is the currently selected lifeform. The animals in the top row all like to eat this
animal or plant. The animals and plants below the center selection are all eaten by this creature.

If there are more than four predators or prey for the current lifeform, you will see an arrow on the left
or right side of the predator or prey row for scrolling through the selections.

Pass your mouse over buttons on the screen and text will pop up that describes each button’s function.
Some buttons may be disabled depending on whether the currently selected lifeform is an animal or

a plant. For example, plants do not make sounds, so the Sound button will only be enabled when the
currently selected lifeform is an animal.



Index

Clicking on the Index tab switches the Food Web screen to the
Index screen. The Index is similar to the Food Web but it organizes
the information in a different way. The main difference is that the
Index allows you to see a list of all available animals and plants.
On the left side of this screen is a list of creatures and plants.

The Index list can be narrowed or expanded by clicking on the
categories on the right side of the Index screen. For example, if
you would like to see only small plants listed in the Index, click on
the Plants only button and the Small button. The center of the
screen displays the currently selected lifeform. Notice that the predators of the current animal or plant
appear in red in the Index list. Similarly, prey of the current animal or plant appear in green.

The Kresch

When Boss Nass first explains the mission he has
for you, he promises you the help of R2-D2 and

Jar Jar (well...he's company anyway!). Boss Nass
also gives you a "sacred, wise creature” known as the Kresch. The
Kresch is a quasi-sentient mollusk that has stored much knowledge
about the Gungans and their way of life. This creature looks like a
large greenish shell when closed and like a beautiful encyclopedia
when open. It is a wonderful source of information. The Kresch is
always available to you in the lower, left-hand corner of your screen.
To open it, simply click on it.

The Kresch contains information about all the creatures and plants in the game, including creatures
you have designed yourself in CREATE-A-CRITTER. On the far right side of each Kresch entry are three
buttons you can click to look up information: Animals/Plants, Ecology and Civilization (e.g. Who is
Queen Amidala, anyway?), or you can click a fourth button, Table of Contents, to view an alphabetical
listing of all entries contained in the Kresch.

(1) Blast-Off

Once you are satisfied with the mix of animals and plants you have loaded onto your ship, it’s time to blast

off. Click on the Blast-off button located in the lower left of your screen, next to the top of the Kresch.
R2-D2 will analyze your mix of animals and plants, and inform you of any problems. Once R2-D2 has

15
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performed this analysis, you may continue with the blast-off, or go back and change your selections. To go
back and adjust the contents of your ship, click the Abort Launch button. If, however, you are sure that you
are ready to leave Naboo and fly to the moon, confirm that you would like to launch your ship by clicking
on the Confirm Launch button.

Note: This step happens automatically in the Beginner game.

Choose a site

In the Beginner game, R2-D2 analyzes the possible landing sites and chooses the
one best suited for the plants and animals on board your ship. In the Advanced
game, however, you must strategize about where to create your new ecosystem.

To examine a landing site, click on a site number on the holographic image of the moon. Notice how

the map at the upper left of your screen changes to show the terrain of the landing site you selected.

Try to pick a site that has the right types of land and water for the creatures on your ship. Consult the
Info button in the Food Web, or read the Kresch for information about where things like to live. You can
also receive feedback from R2-D2 to assist you with deciding which site will work best for the creatures
you have selected. To get help from R2-D2 in choosing a site, first click a site number, then click on R2-D2.

Once you've decided on an ideal landing site, click the corresponding site number, then click the

@ Land at Site button (where the Blast-off button used to be). You can also double-click the chosen

site number on the moon.

ER-1C Probe Droid

=, After your ship lands on the moon, a probe droid is automatically released from your ship. The
probe droid splits in two. One part will monitor the underwater Gungan city and the other part
flies into the sky and releases bio-sensors that will monitor the surface animals and plants. The
images these probes send back to you will be what you see in your holoviewer.

Ship Console

Although it appears that you are looking through the cockpit window of your Mantaris Amphibious
Transport ship, you are actually looking at a holoviewer screen. The holoviewer displays images sent back
to you from the probe droid you just deployed.



the Kresch

Species Indicator
Zoom Control Critter Cam

Slider Bubble

Tool Selector
Population Graphs

Landscape

Boss Nass Comlink Harvest R2-D2
Gungan City/ Surface
Zoom Control

This control lets you adjust the magnification of your holoviewer. Click on the Slider
Bubble and drag it up or down with your mouse to achieve the view you prefer.

Critter Cam

When Critter Cam is on, the holoviewer will track the currently selected creature
and try to keep it on screen. You can turn Critter Cam on and off by clicking the
Critter Cam button. Releasing an animal or plant automatically turns Critter Cam
on and selects the most recently released lifeform.

Species Indicator

At the center of your ship console is the Species Indicator. It is a blue circle that shows
the currently selected species of plant or animal. If you move your mouse over the
Species Indicator, the name of the current species will appear. Clicking on the Species
Indicator opens the Food Web or Index, whichever you were last viewing.

Tool Selector

The Tool Selector shows the tool that you currently have selected and lets you change
your tool. Clicking on the Tool Selector pops up a menu of the four tools you can
choose from: Release, Bio-Scan, Stun, and Capture. These are discussed below.
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Tools
Release

Select the Release tool and move your mouse over the moon’s surface. Notice how
an image of the currently selected critter is carried at the tip of your mouse cursor.
Click on the moon’s surface to release the currently selected species.

If the plant or animal can't live in the terrain your cursor is over, a red “prohibited”
circle will appear. If you try to release the critter in a prohibited terrain, R2-D2

will also tell you that critter can not live in that terrain, and will recommend

a different terrain.

Bio-Scan

Selecting the Bio-Scan tool makes the Bio-Scan screen appear in the upper right of
the holoviewer, and changes your cursor to the Bio-Scan cursor. Click on an animal
or plant to see how it is doing or to track it with Critter Cam. Information about the
selected critter and its species is displayed in the Bio-Scan window.

Stun

Select the Stun tool and click on an animal. Your probe droid will temporarily
immobilize it with a stun beam. This can be useful if a carnivore is about to eat an
endangered herbivore, if an animal is starving and you want to release food for it,
or if a hungry predator seems too slow to catch its speedy prey.

Note: Stun does not work on plants.

Capture

The Capture tool lets you return a plant or animal to your ship. Select the Capture
tool and click on the animal or plant you want to capture. In the Advanced game,
you won't be able to capture a lifeform if your ship has no room for it.

Population Graphs Button

Clicking on the Population Graphs button brings up the Population Graphs screen. This
screen has two tabs for charting the progress of your ecosystem. The first tab (named for
the currently selected species) shows you how many of the currently selected species are on



the moon (i.e. the population). If you click on the Graph All tab on the right hand side of
the screen, you will be able to see how all the creatures and plants on the moon are doing.

The Population Graphs screen also allows you to graph and compare the Gungan population
and the Bio-Score of your ecosystem. Notice that the Bio-Score sometimes goes down as the
Gungan population goes up. They are interconnected.

Landscape Button

Clicking on the Landscape button opens the Landscape screen. Use the Landscape screen
to change the terrain on the moon. Click on the new type of ground or water you want
(e.g., Deep Swamp). Then click on Start Landscaping. Click and drag your mouse across
the moon’s surface to show the Z3-NO landscaping droid the area you want changed.

Boss Nass Comlink

Click on the Boss Nass Comlink button to find out how the new Gungan city is doing and if
they need anything, such as food or building materials.

Gungan (City Button

Click the Gungan City button to change the holoviewer from the surface of the moon
to the new underwater city of the Gungans. Click this button again to return to the view
of the surface.

Map

The circular screen at the upper left of the holoviewer is a map of the
moon's surface at your site. To rapidly move to a particular point on
the map, just click on it. The holoviewer screen will instantly change
to the new view. If you scroll too far, you will come to the edge of
your probe droid’s sensor range, which will appear black. You can not
develop an ecosystem beyond the boundaries of your probe droid’s sensor Plants / Animels
range. Scroll in the opposite direction to return to the playable area.

One way to use the map is for observing your plants and animals from a great distance,
thereby seeing barren areas, overpopulation problems, etc. Each lifeform growing at your
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site is displayed on the map as a colored dot. Three buttons on the right of the map allow
you to set what is displayed on the map - Plants, Animals, or Both. Plants show up as green
dots. Herbivores (plant-eating animals) show up as yellow dots and carnivores (meat-eating
animals) appear as red dots.

Bio-Score and Gungan Population

These two displays appear in the upper-right of the holoviewer. The Bio-Score is calculated
by how many lifeforms and how many different species there are on the moon. The Gungan
population is simply how many Gungans are currently living in the new underwater city.

Main Menu Button

This button is in the top center of the holoviewer. Clicking this button will return you to the
Main Menu. A dialog box will ask you if you first want to save your game.

Menu Bar

The Menu Bar is generally hidden while you are playing The Gungan Frontier. If you move
your mouse cursor to the top of the screen, the Menu Bar will appear.

The Menu Bar has the following menus and options:

File > New Game Disasters > Critter Escape
Load Game... Disease
Save Moonquake
Save As... Pollution Spill
Save Picture... Probe Droid Malfunction
Exit Toxic Cloud

) Allow Random Disasters
Settings> Slow

Normal Help > Bubble Help

Fast R2-D2 Auto Help
Pause Boss Nass Auto Help
Name Lifeform... Keyboard Shortcuts...
Find Lifeform by Name...

Options...

Jar Jar Asleep
If you are playing a mission, the following will also appear in the Menu Bar:

Missions> Show Goal
Restart Mission



Release Lifeforms

Once you are on the moon and your probe droids are deployed, you are ready to create an ecosystem from
scratch! In the Advanced game, it is a good idea to release plants first so the animals have something to
eat. In the Beginner game food for animals is released automatically. Select the Release tool to release the
species in the Species Indicator. Use the Food Web to select other species. For more information about
releasing lifeforms, see SHIP CONSOLE in the PLAY section of this manual.

@ marvest

One of your main goals in The Gungan Frontier is to build a thriving Gungan city. To do this,
you must not only build a healthy ecosystem of plants and animals on the surface of the
moon, but also control how much the Gungans harvest from your carefully built ecosystem.

Click on the Harvest button to open the Harvest screen. The Harvest Screen allows you to
control how much of any species the Gungans can use for food and construction of their
city. The settings range from None to A Lot.

For an explanation of how the harvest settings work, turn on Bubble Help and move your mouse over
the harvest settings or read GAMEPLAY STRATEGY in this manual.

'Thecnnganﬂty

Click on the Gungan City button on your ship console to see how the underwater Gungan city is doing.
Text information about how the city is doing appears in the Bio-Scan window in the upper-right corner
of the holoviewer.

Note: Bio-Scan is always on in the City View of the holoviewer.

How Harvesting Affects the Gungan City

The Gungan City will grow and shrink depending on what and how much you allow the Gungans
to harvest from your surface ecosystem. When more is harvested than the city currently has a use
for, the Gungans store the excess. When you are looking at the city, these excess supplies are shown
in the Bio-Scan window in the upper right corner of the holoviewer. Food Supplies and Building
supplies let you know how much raw material is coming into the city from harvesting compared

to how much stuff the city is using. If they both show “increasing” the city is probably growing
(i.e., there is more than enough food and building supplies). If they both read “decreasing” or
“empty” the city is probably shrinking, or will start shrinking soon.
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Bubble Buildings

The Gungan city is made up of bubble buildings. As the population in
your Gungan city grows, so will the diversity of the bubble buildings.

Click on any bubble building. Information describing that particular
building will appear in the Bio-Scan window in the upper right corner
of the holoviewer. If you have no buildings in your city you probably
aren’t harvesting enough, or aren’t harvesting the right species from
your surface ecosystem. Better click on the Harvest button and get to work!

e Seftings Disasters Help

Bubble Help

Turn on Bubble Help by pressing the ' 4 key or (2 key on your keyboard. You can also turn on
Bubble Help with the Menu Bar. Move your cursor to the top of the screen to make the Menu Bar
appear. Click on Bubble Help under the Help menu.

When the cursor changes to a question mark, move the cursor to the area of the screen with which
you need help and a bubble of helpful text will appear. Clicking anywhere will turn off Bubble Help.

R2-D2

R2-D2 uses the data transmitted from your ER-1C probe droid to monitor the lifeforms on the

surface of the moon. Clicking on R2-D2 causes him to analyze the ecosystem and translate his beeps
and whirrs into text. When R2-D2 Auto-help is on, R2-D2 will tell you how the ecosystem is doing and
what the currently selected lifeform is up to. You can turn R2-D2's auto-help feature on and off via
the Help menu. You can click on R2-D2 in the right hand corner of your screen at any time and he’ll
analyze the new ecosystem for you.

Boss Nass

Boss Nass, leader of the Gungans, will keep you up-to-date on how the new underwater Gungan
city is doing. Click on his call button on your ship’s console to see if the Gungans are in need. When
Boss Nass Auto-help is on, he'll automatically pop up from time to time. You can turn his Auto-help
feature on and off from the Help menu.
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Here are some helpful hints on how to get the most out of The Gungan Frontier. Most of the hints are for the
Advanced game, but they can also help you in the Missions and the Beginner game as well.

General

* There is a lot of good advice in Bubble Help. Turn on Bubble Help from your keyboard with the ' .

or ) keys. Move the mouse cursor around the game screen and read the Bubble Help that pops up
for each component.

* Once you are on the moon, start by releasing plants. They are the base of the food chain and without
them, you cannot have an ecosystem.

* Use keyboard shortcuts to carry out your actions more quickly. For a list of shortcuts, refer to Keyboard
Shortcuts in the Help menu.

* Save your game regularly. Sometimes small changes have surprising results and drastic effects can show
up in your ecosystem. If things don't go as you hoped, you can always reload your saved game.

Loading your Ship

* Bring the maximum number of plant and animal species that your ship can hold.
* Heed R2-D2's feedback about critters not having food. Also be aware of which lifeforms have no predators.

* Try to load plants and animals that provide a lot of resources to the Gungans. See GUNGAN CITY
on the following page for more information.
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Game Speed Settings

* Use Slow, Fast, and Pause in the Settings menu to your advantage.

* The simulation keeps going while you read the Kresch or use the Food Web or any of the other screens.
Use Pause when you will be studying a screen for a while so the ecosystem doesn’t get out of control
without you noticing.

* If too much is going on and things are getting out of control, you might set the game to Slow or Pause,
which will give you more time to sort it out.

Harvesting

* Don't start harvesting right away. First let your ecosystem build up to a Bio-Score of 1000 or more.

* Some and Maintain are the best settings for getting a stable city.

* Setting the harvest rate to A lot is good for reducing the population of a troublesome species. This
setting will quickly make the species die out. Use A lot with caution.

* Greedy harvesting (i.e., A lot) will get the city growing quickly at first. However, A lot can not be
sustained and the city will quickly collapse.

* When a species population has grown to fill up its terrain, a harvest setting of Some or Maintain

will result in almost NO harvesting. These two settings collect critters based upon how much new
growth there is. If a species has no room to expand there is almost no new growth and therefore not
much is collected.

* To maximize the harvest of a particular species, set the harvest rate to Maintain when the species popu-
lation is at 50% of its terrain limit. For example, if the muddy ground at your site can hold about 1000
splinter ferns, setting the harvest rate of splinter ferns to Maintain when the splinter fern population is at
about 500 will give the Gungans the best yield and help their city the most over the long run. Of course,
this assumes that the splinter fern isn’t being gobbled up by hungry herbivores.

Gungan City

* You should first try to build up a thriving ecosystem on the surface of the moon and THEN worry about
building the city.
» Harvest the species that provide the most resources to the Gungans. To find out how useful each critter
is to the Gungans, click the Info button in the Food Web, or consult the Harvest screen.
* Get familiar with how much food and shelter the different plants and animals provide to the Gungans
when they are harvested. Some provide “a lot” of shelter or building supplies (e.g., bubble spore), and
some provide “a lot” of food (e.g., nuna).
* Keep in mind how fast the different plants and the animals reproduce. Even if a species provides a lot of
food and shelter when harvested, if it only reproduces slowly there won‘t be enough to help a big city.
* Different types of buildings get built at different Gungan population levels. The hardest buildings to get
are the Queen’s Monument and the Jedi Monument.
* The color of the buildings depends on what is harvested. If you only harvest one species, all of your
buildings will be the same color. Boring!
* If the buildings are popping, the Gungans are moving out, supplies are empty and you can't seem to
harvest enough, what do you do? You've probably built a bigger city than your ecosystem can support.

24 Or perhaps a key species that other species depend on has gone extinct. You should probably hit Pause,



examine your ecosystem and see if you can salvage it. You might lower the harvest rates of some key
species that your ecosystem depends on. Use the Bio-Scan on different species and see who's been eating
what. You may have to let your city get smaller before you can get it to grow again.

Disasters

 Critter Escape: By accident, Jar Jar releases some of every species you have on board your ship. You can
use multiple clicks of the ﬂ key on your keyboard or the FIND button in the Food Web to track down the
species you don’t want on the moon. When you find them you can use the Capture tool (hint: press the ﬂ
key on your keyboard) to return them to your ship.

* Disease: There’s not much you can do about this one. The disease will run its course over time. If you
have healthy members of the diseased species on board, you might release them to help maintain the pop-
ulation. Newly released lifeforms will not have the disease. Be careful though. Animals that eat infected
food will become diseased themselves.

* Moonquake: The actions you should take depend on where the moonquake hits and how badly it
damages your ecosystem. If it strikes where you have no plants or animals, no harm done. If it strikes in a
heavily populated area, you might try to repair the damage by releasing similar plants and animals to the
ones that were damaged in the quake. If you don't have any on your ship you might capture lifeforms
from one area and release them near the epicenter of the quake to repopulate the area.

* Pollution Spill: The Gungan city has leaked some nasty, toxic sludge that has floated up to the surface of
the deep swamp. It kills all the plants and animals that touch it. Use your Z3-NO landscaping droid to
clean up the mess. If it were only so easy on our planet.

* Probe Droid Malfunction: This disaster doesn’t really cause too many problems. If you wait a bit, all the
critters should thaw out.

» Toxic Cloud: This is one of the nastier disasters. It kills all of the plants on the moon. You better release a
lot of plants fast or your ecosystem will quickly perish. If you don't have any plants left on your ship, you
are in BIG trouble. You should probably start a new game.

Fun Lifeform Facts

* If the pom hoppers seem like they aren’t reproducing, it is probably because you did not release any
poms. Check out the Kresch entry on pom hoppers for more information.

* The suma plant needs clodhoppers to spread its seeds. Without the clodhopper, the suma will

not reproduce.

* Bubble spore seeds are carried by the wind. Every time you play, the wind blows in a different direction
and with a different speed. Try the Blow in the Wind mission.

* If the male or female narglatches are not making baby narglatches, you might not have both a male
and a female on the moon. For all the other species, you don’t need a male and a female. The narglatches
are different.

* Have you watched what happens when a shiro meets a tooke trap? If not, you should check it out. Their
symbiotic behavior is similar to hermit crabs and sea anemones.

* Have you found out what happens to a rancor when it eats a tooke?

* Have you watched a veermok eat a shaupat?
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Printing

The Gungan Frontier does not directly support printing. However, if you would like to print a picture of your
ecosystem or the new underwater city, you can use the Save Picture function in the File menu. This will
save a document called ScreenDumpX (the X will be replaced by a number) into the Gungan Frontier

directory on your hard drive. You may then load the saved picture into your favorite graphics program
for editing and printing.
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How to Contact Lucas Learning Ltd.

Lucas Learning has set up a variety of services to provide you with information about our latest games, hint
and gameplay assistance, and technical support.

Hint Line

If you need a hint, you may call our automated Hint Line. The average call length is three minutes. This
service requires a touch tone phone.

NOTE: You must be at least 18 years old or have your parents’ permission to call.

U.sS.

1-900-740-JEDI (1-900-740-5334)

95 cents per minute

(The option to speak with a live Hint Operator is also available through this number)

Canada
1-900-677-JEDI (1-900-677-5334)
$1.25 (U.S.) per minute

Where to Find Us Online

Visit the Lucas Learning Web site at www.lucaslearning.com. You can reach us through the Technical
Support section of the Lucas Learning web site. From there, you will have the option to receive online
technical support through the Help Me, Obi-Wan Kenobi... page, browse technical documents, or leave
a message for an online representative.

Help Me, Obi-Wan Kenobi...

We are proud to feature the Help Me, Obi-Wan Kenobi... page, which is available in the Technical Support
section of the Lucas Learning web site at www.lucaslearning.com. Here, Obi-Wan offers interactive solutions
to technical issues based on information you provide. Obi-Wan offers technical support 24 hours a day, seven
days a week.
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Technical Support Phone Number

This number is for technical assistance only. Hints will not be given out over the Technical Support
line. When contacting us, please be sure to specify which type of computer (IBM-PC or Macintosh)
you are using.

If you need technical assistance, please don't hesitate to contact us after reading the Troubleshooting
Guide and the ReadMe.txt file. For your convenience, if you cannot get through to a representative
by phone and you have access to a fax machine or any of our online areas, please consider contacting
us through one of these alternate means.

When contacting us, please be sure to provide us with as much information as possible. Make sure

to note the exact type of hardware that you are using in your system, including: your version of
Windows, your sound card, CD-ROM drive, amount of RAM present, and the speed and manufacturer
of your processor. If your computer is a Macintosh, please note the specific model number of your
system, and the version of the MacOS you are using. Make sure to include the title and version of the
game, and a detailed description of the problem.

You can reach our Technical Support department by calling (415) 448-8000. We are available to help
you Monday-Thursday from 8:45 a.m.-11:45 a.m. or 1:00 p.m.-5:30 p.m. On Friday we are available
from 8:45 a.m.-11:45 a.m. or 1:00 p.m.-4:30 p.m. (Pacific Standard Time).

Technical Support Fax
For your convenience, we also offer the option of faxing your technical questions to

(415) 448-8999. Please be sure to include all the information about your computer and problem,
as requested above.

When sending us a fax, please include your name, return fax number with the area code, and a voice
phone number so we can contact you if we experience any problems when trying to fax you back.

Technical Support Mailing Address

Lucas Learning Ltd.
P.O. Box 10667

San Rafael, CA 94912
Attn: Product Support



PLEASE READ THIS LICENSE CAREFULLY BEFORE INSTALLING OR USING THE SOFTWARE. BY USING THE SOFTWARE,
YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF
THIS LICENSE, DO NOT INSTALL OR USE THE SOFTWARE, DELETE THE SOFTWARE AND ALL RELATED FILES FROM
YOUR COMPUTER, AND PROMPTLY RETURN THIS PACKAGE AND ITS CONTENTS TO THE PLACE OF PURCHASE.

The computer software, artwork, music, and other components included in this product (collectively the “Software”)
are the copyrighted property of Lucas Learning Ltd. and its licensors (collectively referred to as “LLL"). The
Software is licensed (not sold) to you, and LLL owns all copyright, trade secret, patent and other proprietary rights
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LLL warrants to the original consumer purchaser that the media furnished in this product will be free from defects
in materials and workmanship under normal use for a period of ninety (90) days from the date of purchase (as
evidenced by your receipt). If the media supplied as part of this product proves to be defective, and provided that
the consumer purchaser returns the media to LLL in accordance with the instructions in this paragraph, LLL will
replace the defective media: (a) free of charge to the consumer purchaser, if the media proves to be defective
within the ninety (90) day period following the date of purchase, and (b) for a fee of $5.00 per Compact Disc, if
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(90) day warranty on the media set forth above, the Software and any related documentation or materials are
provided "AS IS” and without warranty of any kind. LLL EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS AND
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. LLL DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED

IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. THE ENTIRE RISK AS
TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU AND YOU (AND NOT LLL) ASSUME
THE ENTIRE COST OF ALL SERVICING, REPAIR AND/OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. UNDER NO CIRCUM-
STANCES INCLUDING NEGLIGENCE SHALL LLL, OR ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS, BE LIABLE
TO YOU FOR ANY INCIDENTAL, INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOST DATA, LOSS OF BUSINESS INFORMATION, AND THE
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LIKE) ARISING OUT OF THE POSSESSION, USE, OR MALFUNCTION OF THE SOFTWARE, INCLUDING WITHOUT
LIMITATION DAMAGE TO PROPERTY AND, TO THE EXTENT PERMITTED BY LAW, DAMAGES FOR PERSONAL
INJURY, EVEN IF LLL OR AN LLL AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES OR LOSS. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY
FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY
TO YOU.

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER RIGHTS DEPENDING ON THE
LAWS IN YOUR STATE. YOU AGREE THAT THE LIABILITY OF LLL ARISING OUT OF ANY KIND OF LEGAL CLAIM
(WHETHER IN CONTRACT, TORT, OR OTHERWISE) WILL NOT EXCEED THE AMOUNT YOU ORIGINALLY PAID FOR
THE USE OF THE SOFTWARE.

If the Software is acquired under agreement with the U.5. government or any contractor therewith, it is acquired
as “commercial computer software” subject to the provisions hereof, as specified in 48 CFR 12.212 of the FAR
and, if acquired for Department of Defense (DoD) units, 48 CFR 227-7202 of the DoD FAR Supplement, or
sections succeeding thereto.

© Lucas Learning Ltd. and its licensors. © Lucasfilm Ltd. & ™.
All rights reserved. Used under authorization.

This is a work of fiction. All of the characters and events portrayed in this game are fictional.
Any resemblance to real persons, living or dead, or actual events, is purely coincidental.

Lucas Learning Ltd.
P.O. Box 10667
San Rafael, CA 94912
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Star Wars® DroidWorks"™ Codie Award
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Choose from 87 unique droid parts and build millions of
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AVAILABLE NOW! CHECK YOUR LOCAL RETAILER, OR ORDER YOUR
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